
 
This user manual should be customized for each 
particular school with Microsoft Word. We would 
suggest completing the page group names; 
descriptions of any relay controlled building 
functions, name descriptions of the schedules, and 
descriptions of the audio sources (CD player, radio, 
etc). 
 

 
In addition, we suggest deleting any sections that do 
not pertain to features actively being used in the 
school. For example, if the school is not using a V-
PDP panel, remove the section of this manual that 
discusses its operation. 
 
 
You may also wish to add some reference to your 
company name along with contact information. 
 
 
After the document is customized, provide the 
school with both a color printed copy and an Adobe 
Acrobat PDF version of the manual. If you do not 
have the software to create PDF files, let us know 
and we will do so for you. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 

 
User Manual 

 
Revision 1.21a 

 
 
 
 
 
 
 
 
 
 

This document contains company confidential information. Do not distribute any 
part of this manual without written permission from Valcom Incorporated located 

in Roanoke, Virginia. 
 

 



Page 3 of 38  2008 Valcom, Inc. 

Telephone System 
Interface Card

Telephone System 
Interface Card

V-CLK 

V-URI

Station Card

V-DSP Classroom 
Clocks 

Auxiliary 
Audio Inputs 

Microphone 
Input 

Programmable 
Push - Button Inputs 

Programmable 
Relay Contact 

Outputs 
SMDR 

Call Switch 

Door Unlock

Call Switch 

Speaker 

Large Message Display 

Office telephones 1 and 2 

Office Telephones 3 and 4  

Phone System CO Ports 

Windows® 
Programming Tool Administrative Audio/Tone Schedule

Distribution Program



Page 4 of 38 
 

 2008 Valcom, Inc. 

Introduction 
 

Congratulations! Your school is using a state of the art 
communication system. This system, Valcom MultiPathTM, is a 
microprocessor-based telephone to speaker communication 
system.  
 
The system allows both calls from office telephones to classroom 
and hallway speakers and calls from classroom speaker locations 
to the office telephones. 
 
Office phones can simply dial the classroom number to speak to 
an individual classroom. The teacher in the classroom can 
respond to the call by directing their voice towards the 
classroom’s speaker. Office phones can also make general one-
way announcements to all or selected groups of speakers.  
 
Individual teachers can call the office by simply pressing the 
classroom’s call button. Once a call button is pressed, the office 
phone will ring and caller ID information will identify which 
classroom is calling. Multiple calls from multiple rooms are simply 
queued. 

 
Individual teachers can make emergency calls to the office by 
simply pressing the classroom’s call button 4 times within 3 
seconds. Emergency calls are given priority over non-emergency 
calls. 
 
The system also provides for class change tones (bell schedules), 
emergency tones, audio distribution and other school system 
controls. 
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Classroom/Hallway Speaker Dial Codes 
 

Dial Code Classroom/Hallway/Teacher Name 
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Page Group Dial Codes 
(dial #∗xxx for Emergency Page to Group) 

 
Dial Code Page Group Name 

#111  
#112  
#113  
#114  
#115  
#116  
#117  
#118  
#119  
#120  
#121  
#122  
#123  
#124  
#125  
#126  
#127  
#128  
#129  
#130  
#131  
#132  
#133  
#134  
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 Page Group Dial Codes 
(dial #∗xxx for Emergency Page to Group) 

 
Dial Code Page Group Name 

#135  
#136  
#137  
#138  
#139  
#140  
#141  
#142  
#143  
#144  
#145  
#146  
#147  
#148  
#149  
#150  
#151  
#152  
#153  
#154  
#155  
#156  
#157  
#158  
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Page Group Dial Codes 
(dial #∗xxx for Emergency Page to Group) 

 
Dial Code Page Group Name 

#159  
#160  
#161  
#162  
#163  
#164  
#165  
#166  
#167  
#168  
#169  
#170  
#171  
#172  
#173  
#174  
#175  
#176  
#177  
#178  
#179  
#180  
#181  
#182  
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Systems Control Dial Codes  
Level 2 or 3 Access Only 

 
Dial Code  Function 

#41∗ On 
#41# Off 

 

#42∗ On 
#42# Off 

 

#43∗ On 
#43# Off 

 

#44∗ On 
#44# Off 

 

#45∗ On 
#45# Off 

 

#46∗ On 
#46# Off 

 

#47∗ On 
#47# Off 

 

#48∗ On 
#48# Off 
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Time Schedule Control Dial Codes 
Level 2 or 3 Access Only 

 
Dial Code  Schedule Name 

#51∗ On  
#51# Off  
#52∗ On  
#52# Off  
#53∗ On  
#53# Off  
#54∗ On  
#54# Off  
#55∗ On  
#55# Off  
#56∗ On  
#56# Off  
#57∗ On  
#57# Off  
#58∗ On  
#58# Off  

 
Dialing #91∗ from a level 3 office telephone, will provide 
verbal confirmation of the current system time. 
 
Dialing #90∗ from a level 3 office telephone, will provide 
verbal confirmation of the current system date. 
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Audio Source Control Dial Codes 
 
These dial codes turn the individual audio sources on and 
off. Distribution of these audio sources is accomplished 
through the Valcom MultiPath Administration Tool. Music 
Distribution via switch input will not be controlled via these 
dial codes. 
 

Dial Code  Audio Source Name 
#61∗ On  
#61# Off  
#62∗ On  
#62# Off  
#63∗ On  
#63# Off  

 
 

Audio Source Monitor via Telephone Dial Codes  
 

These dial codes allow office telephones to monitor any of 
the 3 system audio sources or the system microphone (if in 
use). If sources are not on via dial code or through the 
Administrative Software Tool, then the user will receive a 
busy tone. 

 
Dial Code Audio Source 

#65  
#66  
#67  
#68 Microphone (If active) 
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 Other Office Phone Dial Codes 
 

Access Levels Dial Code 
  

1 2 3 

#110 All Call Page X X X 
#35 Temporary Page Group  
Architectural number, #, ... Architectural number, #, # 

X X X 

#40∗ Enable Automatic Relay Operation 

#40# Disable Automatic Relay Operation  

 X 

X 

X 

X 

#50∗ Enable Automatic Time Schedule  

#50# Disable Automatic Time Schedule  

 X 

X 

X 

X 

#71∗ Enable Call Forward after time-out  
#71# Disable Call Forward after time-out 

#72∗ Enable Immediate Call Forward 

#72# Disable Immediate Call Forward 

#73 Call Pickup 

X 
X 

X 

X 

X 

X 
X 

X 

X 

X 

X 
X 

X 

X 

X 

#94XX Impulse Clock Manual Advance (XX = Minutes) X X X 

##0 Emergency All Call  
##1##1 Tornado Tone On 

##2##2 Fire Alarm Tone On 

##3##3 Emergency Time Tone On 

##4##4 All Clear Tone On 

##5 Stop Emergency Tones 

 X 
X 

X 

X 

X 

X 

X 
X 

X 

X 

X 

X 

##9∗ Crisis COS Enabled  
##9# Crisis COS Disabled 

 X 
X 

X 
X 

∗9 Bump Call in Progress  

∗8 Join Call in Progress 

∗7 Join Queue 

  X 
X 

X 

#91 HHMM Set System Time (Military Time) 

#90 ZMMDDYY Set System Date  (Z = day of week with 
Sunday = 1) 

  X 

X 

Glossary 
 

All Call Page – a one-way 
announcement to all system 
speakers. 
 
Temporary Page Group – 
stations that have been 
combined for a one-time 
announcement. 
 
Architectural number – the 
number that is dialed in order 
to make an announcement to a 
particular area or classroom. 
Same as zone or station 
number. 
 
Automatic Relay Operation – 
timed or cycling relay 
operation. 
 
Call Forward after timeout – 
automatic transfer of 
unanswered calls from one 
office telephone to another. 
 
Call Pickup – answering a call 
from one office telephone that 
is ringing at a different office 
telephone. 
 
Hookflash – Momentarily 
depressing a phone’s switch 
hook in order to access certain 
telephone features. 
 
Crisis COS – a special system 
mode of operation that clears 
all incoming calls and then only 
recognizes emergency calls. 
 
Bump/Join Call In Progress – 
The ability, upon receiving a 
busy indication, for a level 3 
office telephone to release or 
intrude upon an active call. The 
level 3 phone may also simply 
join the queue.  
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The following dial codes are for systems utilizing system 
wiring supervision: 
 

#81∗ Enable fault detection on detecting stations 

#81# Disable fault detection on detecting stations 

#82 Architectural number, #, ... Architectural number, #, # 
Clear individual station fault indication 

#83 Clear all fault indications 

 
 
 

Requires level 3 access 

 
 

Answering Calls (Auto Answer Disabled) 

Function  Procedure 
To Answer a Call Lift handset. (Point of origin of call can be 

announced in handset audibly).  
Press ∗. 

Speak to caller. 

Replace handset. 

Examine Call Waiting List (Voice Announce 
Feature Enabled) 

Scroll through the list by momentarily 
pressing the hookswitch (Flash) after 
each announcement. A beep will sound 
indicating the last call on the list. 

Connect to a Specific Station on the Call Waiting 
List 

Lift handset.  
Press hookswitch (Flash) until the desired 
station number is announced. 

Press ∗. 

Speak to caller. 

Replace handset. 

Ignore Station on Call Waiting List Press #.  
Receive dial tone. 

Dial desired station number. 
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Function  Procedure 
Call Transfer Press hookswitch (Flash) to place call 

on hold.  
Dial administrative to receive call. 

Third party answers. 

Press hookswitch (Flash); all parties 
connected. 

Hang up - or announce call and hang 
up. 

Conference Calls Press switchhook (Flash) to place call 
on hold.  
Dial administrative to be included in call.

Third party answers. 

Press hookswitch (hookswitch flash); all 
parties connected. 

Bump Call in Progress (level 3 only)  
(Allows an Administrative Station to interrupt a 
call in progress and speak to desired station). 

Dial desired station #.  
Receive busy tone. 

Press ∗ 9. 

Connected to desired station. 

Join Call in Progress (level 3 only)  
(Allows an Administrative Station to dial a busy 
station and join in conversation). 

Dial desired station #.  
Receive busy tone. 

Press ∗8. 

Join conversation. 

Join Queue (level 3 only)  
(Allows an Administrative Station to be added to 
the call queue of desired Administrative Station). 

Dial desired administrative station.  
Receive busy tone. 

Press ∗7. 

Added to call of desired station. 
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Page Priority 
 

Priority is a very important concept in the Valcom MultiPath 
system. Many different audio paths may be active in the system 
simultaneously. Often a speaker will be requested to be the 
recipient of more than one audio path at a time. Rather than mix 
all the audio together, the system assigns each type of call a 
priority, and only allows the highest currently active priority to be 
heard. As an example, suppose station 101 is listening to a 
background music source. When a group call page is originated 
that includes this speaker the music will turn off at the speaker for 
the duration of the page. And, if during the page a class change 
tone becomes active, it will override the group page. When the 
tone ends the page will automatically reconnect, and when the 
page ends the music will reconnect. 

Priorities in the system, from highest to lowest, are: 

 

Emergency handsfree 

Emergency all call or tone 

Emergency group call 

Time tone 

Handsfree 

All call 

Group call 

Background music 
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Incoming Call Priority 
 

 
Classroom calls placed to office telephones may have different 
levels of priority. Valcom MultiPath provides for 3 different level of 
call button priority - normal, urgent and emergency. If you are 
using caller ID telephones with your system, Valcom MultiPath will 
provide visual indication of the call priority as shown below: 
 
 
 
000-200-0100  = Normal call from room 100 
000-300-0100  = Urgent call from room 100 
000-500-0100  = Emergency call from room 100 
 
 
 
 

These different levels of priority are used to determine a calls 
placement in the queue. When multiple calls are queued at an 
office telephone, emergency calls will be placed at the top of the 
queue (answered first) followed by urgent calls, and finally normal 
calls).  
 
 
Please note that emergency calls may (dependant upon the 
telephone system) also cause idle office phones to ring with a 
different (faster) ring pattern and will be displayed on the system 
large display (if so equipped) in red characters. 
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System Volume Adjustment 
 
All of the Valcom MultiPath system volume controls have been 
preset at the factory for optimal levels. If your system speakers 
feature individual volume controls, these may be used to adjust 
individual speakers. 

 
 

Test Rooms  
 
 The test room feature is intended to minimize page and tone 
disruptions in rooms where students have been temporarily 
assembled for testing (such as SAT tests). Test rooms may be 
defined via dial code #85 as a sort of temporary page group. 
When a station is defined as a test room, it will be excluded from 
all call and group pages except through dial code #36 which will 
enable a one way call to all test room speakers, emergency all 
call or emergency group pages. The following dial codes apply:  
 
 

#36 Page to all "Test" rooms only 
#85 Define test rooms  

Architectural number, #, ... Architectural number, #, # 

#86 Reset individual test rooms to normal operation 

Architectural number, #, ... Architectural number, #, # 

#87 Reset all test rooms to normal operation 

 
Level 3 Access is required for all test room dial codes 

 
Test rooms will automatically reset at midnight each day 
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Controls and Features 
 

1. Manual Emergency Buttons - Default Settings:  (Consult 
Programming Section to change setting).  A - FIRE Tone, B - 
TORNADO Tone, C - EMERGENCY Tone, D - ALL CLEAR Tone, E - 
MICROPHONE/ALL CALL PAGE Tone 

2. Program 1 Source Bass, Treble, And Volume Controls.  VU level - 
Indicated program audio level. 

3. Program 2 Source Bass, Treble, And Volume Controls.  VU level - 
Indicated program audio level. 

4. Program 3 Source Bass, Treble, And Volume Controls.  VU level - 
Indicated program audio level. 

5. Monitor Select Switch - Allow selection of one of the three programs 
for monitoring purposes. 

6. Monitor Speaker - Provides audio of the selected program (can be 
changed by moving the selector switch). 

7. Microphone Input - Provides mic input for external all call. 
8. Audio Input Jacks  - Provides facilities to input auxiliary program 

source. 
9. Volume Control for Monitor Speaker - Sets monitor volume for 

selected program. 
10. Audio Output Jacks - Permits connection of external amplifier/monitor.
 
 

Figure 1 – V-PDP Front View 
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Administration Tool 
 

Valcom MultiPath is a state of the art microprocessor based school 
communications system. In addition to the user-friendly dial codes 
used to call the system speakers and to access specific system 
functions, your Valcom MultiPath system has been provided with a 
computer based Administration Tool. This user friendly tool is used to 
set up time schedules for class changes and to distribute audio from 
any of the 3 possible system music inputs to any or all of the system 
speakers. 
 
When you invoke the Valcom MultiPath Administration Tool and 
connect to the system, this is the first screen that will appear: 
 
 
 
 

 
 
 

Choose your method of 
connection 
 
Enter your system password 
(default is 825266) 
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Once the configuration is received from the Valcom MultiPath System, 
you’re ready to view or change the system audio groups, time 
schedules, time groups, date and time and to distribute system music 
sources. 
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You may label each aux
source with an
identifying name 

You have the option to view either the default
station numbers, by the assigned architectural
number (usually the classroom numbers), by
caller ID description or by all with sorting
capability.  

You can turn each of
the individual music
source inputs (Aux
Sources) off and on
by clicking the Play
or Stop Buttons 

You select which speakers will 
receive the music by placing a 
check mark next to the 
architectural or station numbers for 
those speakers.

These tabs select which music
source input (Aux Source) you
want to manipulate. 

The add function allows adding
stations from any combination
of the 72 audio groups. 
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 Fault Detection  
 

If you system uses wiring fault detection, and the integrity of the wiring 
to your call switches or speakers has been violated, or if any of the 
system cards suffer communications failure, the following screen will 
greet you upon invoking the Administration Tool. 

 
 
 
 
 
 
 
 
 

This screen shows system cards that are not properly
communicating with the V-CPU4 and all speaker zones
that have wiring problems requiring attention. The
appearance of this screen is accompanied by a repeating
tone through your PC speakers. Users may silence the
tone by pressing Tone Off. Once the faults are corrected,
checking the box next to the corrected station and pressing
Clear will clear faults indications. 
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Schedules 
 

Each classroom/hallway may be assigned to any or all of the system’s 
8 time groups. Each of the 8 time schedules (not to be confused with 
time groups) may be set up to send audio (tone) to any of these 8 
time groups at multiple scheduled times.  

 

When you select the Schedules function, the following screen 
becomes available. This screen allows users to turn schedules off and 
on and to edit the scheduled events. 

Select the schedule that
you want to manipulate by
clicking the appropriate
tab. 

Turn the desired
schedule off or
on with these
buttons

If you’ve disabled automatic
schedule operation by using
dial code #50# or by forcing
a schedule, you can restore
automatic operation by
clicking here 

The Valcom MultiPath system
supports up to up to 255 events
per schedule (system maximum of
1024 events). 

To add an event, simply click Add. To Edit
or Delete an event, simply click on the
specific event and click Edit or Delete (see
next page) 

You can easily copy events from one schedule to the 
next or archive an entire schedule on your computer 
to reload at a future time (great for seldom used 
schedules).

You can name each schedule 

Check which days
of the week you
want this schedule
to run when
automatic schedule
operation is active. 
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The screen that becomes available when you select the Time Button 
allows users to select which speakers (by station number or 
architectural number) will be in the Valcom MultiPath‘s 8 time groups.  

You can name each time group 

When Add or Edit is selected, users 
simply: 
 
Select when you want the event to 
occur (24 hour time format). 
 
Select which action you wish to take 
place at the specified time. 
 
If applicable, select how long you 
want the action to occur. 
 
Select which of the 8 time groups 
will broadcast any audible actions 
by checking any combination of 1 
through 8. 
 
Click OK. 
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The Audio Function allows users to select which speakers (by 
station number or architectural number) will be in the Valcom 
MultiPath’s 72 audio groups.  

On the File menu, users may edit the address
book (used for organizing connection
information), set up system communication
settings, change the system date and time
settings, change the access password, print
reports, enable or disable automatic updates,
card fault detection or demo mode (used for
demonstrating the software). 

You can name each audio group
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Users may update the system date and time by selecting the System 
button: 
 

 

Make sure you
press update
after you adjust
the system date
or time !!

You can opt to set the system time to be
the same as your PC’s time (Synchronize
System) or you can opt to set your PC’s
time to be the same as the system time
(Synchronize PC) 

You can opt to synchronize the system 
time to an Internet time server if an 
Internet time server has been defined 
(Options Menu) 

You can send manual correction pulsed 
to synchronous or impulse type clocks (if 
installed) 

Printing reports allows
users to create a paper
record of the system dialing
plan, schedules, time
groups and audio groups 
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You can opt to synchronize the system time to an Internet 
timeserver if an Internet timeserver has been defined. This 
feature is found under the “Options” Menu). 

Click here to find a list of 
available timeserver 
URLs 

You may add an error to 
your system time if so 
desired  
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The Options menu allows users to define holidays (for the
purpose of automatic time schedule operation), define when
daylight saving time begins and ends (for the purpose of
keeping the system time correct), modify caller ID descriptions
for the stations (up to 15 characters), define when the system
should operate in day mode and night mode and to set up or
modify time server parameters. 

To define a holiday, check the box next
to the holiday that you want to define and
enter the holiday date. When a defined
holiday occurs during automatic
schedule operation, all time schedules
that are denoted to run on holidays will
be active. 
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Daylight Saving Time may
be disabled, automated via
calculation, Internet
timeserver or by manually
entering the dates for the
time change. If Internet
Time server updates are
enabled, manual and date
based options will not be
available. 

You can set up the times that the
system will enter day and night
mode on a per day basis. This is
primarily for the call button class
of service programming. 
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To change Caller ID descriptions, select a station that requires
modification and enter a new caller ID description using up to 15
alphanumeric characters. Use the keyboard arrow keys to navigate
when changing multiple caller ID descriptions. Press OK when
changes are complete.  
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Once the desired updates have been entered in the Administration 
Tool, users simply press the Update button to send the new data to 
the Valcom MultiPath. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Page 32 of 38  2008 Valcom, Inc. 

Glossary 
 
 
 
Automatic Time Schedules – System time schedules may run in one 
of 2 modes of operation. When a schedule or schedules is/are forced 
on via a basic input, only those schedules will be active. Schedules 
forced on via basic input will be on until all basic inputs programmed 
to force schedules are released after which automatic schedule 
operation will resume. When a schedule or schedules is/are forced on 
via a dial code, or through the Administrative Tool, those schedules 
will be active in addition to the automatic operation of all of the other 
schedules. Schedules that are forced on will run regardless of which 
days of the week are associated with them. When Automatic Time 
Schedules are utilized, schedules will run simultaneously following 
their weekday and/or holiday assignments. Schedules that are forced 
on via dial code or through the Administrative Tool return to automatic 
operation at midnight each day. Note that if an event is still playing 
on a schedule when the next event on that schedule occurs, then 
that 1st event is turned OFF before the new event is turned ON. If 
2 Schedules play overlapping events, then the 1st event will be 
momentarily interrupted by the second event. 
 
Bump call in progress – When an office telephone with level 3 access 
calls a station that is busy talking to another office telephone, the level 
3 phone can connect to the busy station and disconnect the originally 
connected office telephone by dialing ∗9. 
 
Confirmation tone – A tone provided to a station speaker indicating 
that the associated call button has been successfully activated. 
 
Crisis mode – When crisis COS is enabled by dialing ##9∗ or shorting 
a designated V-URI input, all calls in queue are dropped. Following 
this purging of queued calls, only emergency calls will be recognized 
by the system. 
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Level 1 Level 2 Level 3 
Dial any station  
Zone page 

All call page 

Transfer calls 

Conference calls 

Manipulate call-in 
queue 

Call pickup 

Call forward 

Program sources 
on/off 

All Level 1 functions 

Emergency all call 

Manual relay control 

Manual schedule 
control 

All Level 2 
functions 

Bump conversation

Join conversation 

Test Room 
Commands 

Day/Night Mode – The system allows for different operation during the 
day than at night. The time that the system enters these time sensitive 
modes is programmable.  
 
Fault Detection – Beginning with V-CPU4 Firmware release 3.10, it is 
possible to monitor the MultiPath system for card “loss of 
communication” faults and for wiring faults. If properly configured for 
fault detection, fault will be reported in the Administration Tool. 
 
Join call in progress – When an office telephone with level 3 access 
calls a station that is busy talking to another office telephone, the level 
3 phone can connect to the busy station and conference with 
originally connected office telephone (and the station) by dialing ∗8. 
 
Join queue – When an office telephone with level 3 access calls an 
office telephone that is busy, the level 3 phone can join the queue of 
the busy office telephone ∗7.  
 
Office phone access levels – Programmable levels of 
restriction/access that can be assigned to any of the office 
telephones. Refer to the following chart for details: 
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Privacy Tone – A tone that sounds over a handsfree talkback speaker 
every 15 seconds to discourage eavesdropping. 
 
Pre Announce Tone – A tone that sounds over a speaker indicating 
that the speaker is now active and an announcement will follow. 
 
System Password – A user definable password that is required to 
allow connection of the Valcom MultiPath Programming Tool or 
Administrative Tool to the system. 
 
Time Groups – The Valcom MultiPath offers 8 time groups. Any or all 
of the system stations may be added to any or all of the time groups. 
These groups are used for the purpose of event distribution (time 
tones, aux source audio) through the 8 time schedules. Note – In 
some versions of Valcom MultiPath, if aux source 1 is enabled, 
then time group 8 will not be available. If aux source 2 is 
enabled, then time group 7 will not be available. If aux source 3 
is enabled, then time group 6 will not be available. 
 
 
Test Rooms – The test room feature is intended to minimize page and 
tone disruptions in rooms where students have been assembled for 
testing (such as SAT tests). Test rooms may be defined via dial code 
#85 as a sort of temporary page group. When a station is defined as a 
test station, it will be excluded from all call and group pages except 
through dial code #36 which will enable a one way call to all test 
station speakers, emergency all call or emergency group pages. 



 

  

The following pages contain programming templates to aid in organizing the information required  
 to program the Valcom MultiPath system.  Please make additional copies as necessary. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Station Programming for Time Groups Template 
 
Note – In some versions of Valcom MultiPath, if aux source 1 is enabled, then time group 8 will not be 
available. If aux source 2 is enabled, then time group 7 will not be available. If aux source 3 is enabled, 
then time group 6 will not be available. 
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Station /Arch # 
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45
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 Time Schedule Programming Template 

Schedule # Schedule Name Schedule #  Schedule Name 
Event Time Tone/Aux 

Source 
Duration Time Group Event Time Tone/Aux 

Source 
Duration Time Group 

   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8

   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8
   1 2 3 4 5 6 7 8    1 2 3 4 5 6 7 8

Schedule Run Days        M  T  W  TH  F  S  S  H Schedule Run Days        M  T  W  TH  F  S  S  H 



 

  

Holiday Programming Template 
Holiday Date 

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

 
 
 
 

Day Night Timing Template 
 Day Mode Start Time Night Mode Start Time 

Sunday   
Monday   
Tuesday   

Wednesday   
Thursday   

Friday   
Saturday   
Holidays   

 

 


